Learn-/Training Document
Siemens Automation Cooperates with Education (SCE) | As of Version V9 SP1
PA Module P01-02
SIMATIC PCS 7 – Hardware Configuration
Matching SCE Trainer Packages for this Learn-/Training Document

- **SIMATIC PCS 7 Software Package V9.0 (set of 3)**
  Order No.: 6ES7650-0XX58-0YS5
- **SIMATIC PCS 7 Software Package V9.0 (set of 6)**
  Order No.: 6ES7650-0XX58-2YS5
- **SIMATIC PCS 7 Software Upgrade Packages (set of 3)**
  Order No.: 6ES7650-0XX58-0YE5 (V8.x → V9.0)
- **SIMIT Simulation Platform with Dongle V10**
  (contains SIMIT S & CTE, FLOWNET, CONTEC libraries) – 2500 simulation tags
  Order No.: 6DL8913-0AK00-0AS5
- **Upgrade SIMIT Simulation Platform V10**
  (contains SIMIT S & CTE, FLOWNET, CONTEC libraries) from V8.x/V9.x
  Order No.: 6DL8913-0AK00-0AS6
- **Demo Version SIMIT Simulation Platform V10**
  Download
- **SIMATIC PCS 7 AS RTX Box (PROFIBUS) only in combination with ET 200M for RTX** –
  Order No.: 6ES7654-0UE23-0XS1
- **ET 200M for RTX Box (PROFIBUS) only in combination with PCS 7 AS RTX Box** –
  Order No.: 6ES7153-2BA10-4AB1

Note that these trainer packages are replaced with successor packages when necessary.
An overview of the currently available SCE packages is available at: [siemens.com/sce/tp](http://siemens.com/sce/tp)

**Continued training**
For regional Siemens SCE continued training, get in touch with your regional SCE contact [siemens.com/sce/contact](http://siemens.com/sce/contact)

**Additional information regarding SCE**
[siemens.com/sce](http://siemens.com/sce)

**Information regarding use**
The SCE Learn-/Training Document for the integrated automation solution Totally Integrated Automation (TIA) was prepared for the program “Siemens Automation Cooperates with Education (SCE)” specifically for training purposes for public educational facilities and R&D institutions. Siemens does not guarantee the contents.

This document is to be used only for initial training on Siemens products/systems, which means it can be copied in whole or part and given to those being trained for use within the scope of their training. Circulation or copying this Learn-/Training Document and sharing its content is permitted within public training and advanced training facilities for training purposes.

Exceptions require written consent from the Siemens. Send all related requests to [scesupportfinder.i-ia@siemens.com](mailto:scesupportfinder.i-ia@siemens.com).

Offenders will be held liable. All rights including translation are reserved, particularly if a patent is granted or a utility model or design is registered.

Use for industrial customer courses is explicitly not permitted. We do not consent to commercial use of the Learn-/Training Document.
We wish to thank the TU Dresden, particularly Prof. Dr.-Ing. Leon Urbas and the Michael Dziallas Engineering Corporation and all other involved persons for their support during the preparation of this Learn-/Training Document.
# Table of contents

1. Goal.......................................................................................................................... 5
2. Prerequisite.................................................................................................................. 5
3. Required hardware and software ................................................................................. 6
4. Theory .......................................................................................................................... 7
   - 4.1 Theory in brief ...................................................................................................... 7
   - 4.2 Distributed architecture of process control systems .......................................... 8
   - 4.3 Process image ..................................................................................................... 9
   - 4.4 Connection to the process ................................................................................. 10
   - 4.5 Distributed I/O ................................................................................................. 11
   - 4.6 References ....................................................................................................... 12
5. Task ............................................................................................................................. 13
6. Planning ....................................................................................................................... 15
7. Learning objective ....................................................................................................... 15
8. Structured step-by-step instructions ........................................................................... 16
   - 8.1 Creating a project .............................................................................................. 16
   - 8.2 Configuring the S7 station ............................................................................... 23
   - 8.3 Connection of the I/O signals ......................................................................... 26
   - 8.4 Configuration of the PC station ....................................................................... 30
   - 8.5 Networking ....................................................................................................... 32
   - 8.6 Checklist – step-by-step instruction .................................................................. 34
9. Exercises ...................................................................................................................... 35
   - 9.1 Tasks ................................................................................................................ 35
   - 9.2 Checklist – exercise .......................................................................................... 36
10. Additional information ............................................................................................ 37
Hardware configuration

1 Goal

In this chapter, students become familiar with the functionality of an automation system. They will be able to configure the selected hardware in the hardware configuration of PCS 7 and check it for consistency. Important settings will be made so that the PCS 7 process control system automatically sets up all the blocks necessary for communication between sensors, actuators and process management level in the automation stations.

2 Prerequisite

This chapter builds on chapter 'Process description', which describes the example plant. There are no further prerequisites for implementing this chapter.
3 Required hardware and software

1 Engineering station: Requirements include hardware and operating system
   (for further information, see Readme on the PCS 7 installation DVD)
2 SIMATIC PCS 7 software V9 or higher
   - Installed program packages (contained in SIMATIC PCS 7 Software Trainer Package):
     - Engineering → PCS 7 Engineering
     - Engineering → BATCH Engineering
     - Runtime → Single Station → OS Single Station
     - Runtime → Single Station → BATCH Single Station
     - Options → SIMATIC Logon
     - Options → S7-PLCSIM V5.4 SP8

![Engineering Station]

2 SIMATIC PCS 7 V9 SP1 or higher
4 Theory

4.1 Theory in brief

During hardware configuration, the real components for acquisition of measured values and for output of signals for process control are inserted and arranged in a tabular representation of the configuration. As shown in Figure 1, this process describes at which slot or in which order each input/output module is placed. In addition, you assign the input and output signals to a defined memory location in the process image and assign the module parameters. If fieldbuses are used, unique device addresses are specified as well.

![Figure 1: Mapping of the real configuration to the configuration table](image)

When the settings are saved and compiled, an internal consistency check takes place (do all modules match, have addresses been assigned twice, etc.). As soon as the configuration is consistent within itself, the blocks necessary for the communication of the process data are set up without user assistance and can then be loaded to the automation stations (AS) of the control system. These now have all the information to initially determine whether the installed configuration corresponds to the one that was configured. Furthermore, they ensure that the process data is available for further processing at the automation systems at the desired sampling rate. The fact that extensive measures are also taken in case of errors, such as the automatic issuing of suitable messages and alarms, remains invisible for most users.
4.2 Distributed architecture of process control systems

Scalable process control systems such as PCS 7 cover a large range of processes. Applications include small laboratory plants with only a few sensors and actuators up to large plants with a hundred thousand process tags. To cover this broad spectrum, special structures are required. A typical component structure that can be easily expanded looks like this:

- On the process management level, an operator system (OS) consisting of one or more operator stations is used. Operators can control and monitor the plant via this OS.

- On the control level there are one or more automation stations (AS) that execute the open-loop and closed-loop control functions in real-time. These systems are to do their job regardless of OS failures. They consist at least of a power supply (PS) and a CPU and, if necessary, communication modules (CP).

- On the field level, sensors and actuators acquire the states of the technical processes and influence these processes, respectively.

While all components can run on a single computer system in the laboratory, as shown in Figure 2, it is advisable to distribute the components after a certain plant size (e.g. a pilot plant) is reached to better handle the complexity. For the data exchange between these components, various bus systems are used depending on requirements, e.g. bus systems with the real-time characteristics required for the process data communication.

![Figure 2: Scalable structure of the PCS 7 process control system](https://example.com/figure2.png)
### 4.3 Process image

The central processing unit (CPU) processes the automation programs on the automation stations (AS) the same way as other computers. The control programs are processed cyclically. When signals from the process are processed, the program does not access the connected input and output modules directly. Instead, a so-called process image is created in which all signals are read in at once and stored at the beginning of the cycle.

There are two reasons for this: First, accessing the process image requires considerably less time because it is stored in the internal memory of the CPU. Second, this approach ensures that the input information has all been collected within a defined time window – regardless of the execution time of the control program. This data consistency is attained by reading in the signals of the input modules in the process image input (PII) once per cycle. The program is then processed, and the results are written to the process image of the outputs (PIQ).

Once the entire program has been processed, the data is written from the PIQ to the output modules and thus output to the process. The process image of the inputs is then updated again, as shown in Figure 3.

![Figure 3: Reading and writing of inputs and outputs during processing of the PLC cycle](image)

Legend:
- Access to hardware
- Access to process image
- Processing sequence
4.4 Connection to the process

The process signals acquired by the sensors, such as temperature, pressure, level and flow rate, are converted into an electrical signal with transducers. If the measuring device is not connected directly via a fieldbus, the signal is usually converted into a standardized electrical signal. This signal can then be acquired on the automation system side by a standardized signal module.

Because process industry plants are expected to acquire anywhere from a handful of measured values up to tens of thousands of measured values, it must be possible to select, clearly assign and parameterize the measuring module during the automation planning phase. For example, the user initially arranges the necessary signal modules in the hardware configuration virtually. In addition, the above-mentioned assignment of memory space in the process image is made for the signal modules. As soon as a signal module is inserted in the configuration, sufficient memory space is automatically assigned in the process image. There is the option to manually change the automatic assignment, but the size of the memory area in the CPU should always be taken into consideration.

Different signal modules are used, depending on the type of signals. For binary signals, DI (Digital Input) and DO (Digital Output) modules are used. The individual signals are organized in bits; this means each input/output signal occupies one bit of the process image. However, signal modules usually acquire 8, 16 or 32 signals at once.

For analog signals, AI (Analog Input) and AO (Analog Output) modules are used. Analog signals are usually organized in words (16 bits). Each analog input or output signal occupies 16 bits of memory, as shown in Figure 4. For this, the analog input module converts the analog process signal to a digital form. Depending on the resolution, only the higher order positions are occupied and ‘0’ is written to the lower order positions. Analog output modules convert the digital output value to an analog signal. In the case of analog signals, modules are distinguished not only according to the number of signals but also according to their resolutions, for example, 2x12 bits, 8x13 bits or 8x16 bits.

Figure 4: Symbol table of an AI module (Analog Input)
4.5 Distributed I/O

When sensors and signal sources are located far away from the automation system, wiring can become very extensive and complex. In addition, electromagnetic interference may impair reliability. The use of distributed I/O devices is suitable for these types of plants.

– The automation system is at a central location.
– One or more I/O devices (input and output modules) operate locally at a decentralized location.
– The data transfer between the I/O and the automation system [1] takes place via PROFIBUS DP (Distributed I/O). For this purpose, the AS and I/O must be equipped with corresponding communication modules.

A SIMATIC ET 200M was selected as the distributed I/O device for the plant described in the previous chapter. The I/O modules of the proven S7-400 automation system are connected to an interface module (IM 153-x) that ensures communication with the AS. Figure 5 shows a typical configuration. On the right, several digital and analog input and output modules are connected to the IM 153-1 interface module. The process signals coming from the field are connected directly to the routing level below the input and output modules; from there, short cables lead to the modules, thereby allowing errors in the wiring to the field to be quickly eliminated.

In the hardware configuration, the SIMATIC ET 200M is connected to a PROFIBUS DP line of the AS, as shown in Figure 6. The hardware configuration automatically suggests addresses that are not yet used in the selected subnet. The user assigns input and output modules to the slots of the ET 200M, as described below.

![Figure 5: ET 200M Distributed I/O Device (source: Laboratory plant TU Dresden)](image-url)
Figure 6: Hardware configuration of an ET 200M [2]

4.6 References


5 Task

In this chapter, the **PCS 7** project for the multipurpose plant is to be created using a wizard.

Next, the S7 station contained in project is configured. In the example, the S7 station is a SIMATIC S7-400 with a CPU 414-3 DP and a CP443-1 communications processor for linking to Ethernet via the TCP/IP protocol.

An ET 200M is used to connect the I/O signals for controlling the actuators in the plant and for acquiring the input signals. This modular field device is connected to the CPU via the PROFIBUS DP fieldbus.

The PC station, as the master computer with the **PCS 7** software and **WinCC** for visualization, must also be configured. Any PC or laptop with a standard Ethernet interface is used for this.

The master computer, as operator station (OS), and the CPU, as automation station (AS), are interfaced via Ethernet and the TCP/IP protocol.

The project is also developed on the master computer. Consequently, the master computer operator station (OS) and the engineering station (ES) are combined.

![Diagram](image.png)

**Figure 7**: Plant configuration for multipurpose plant

**Notes:**

- *The abbreviations for engineering station (ES), operator station (OS) and automation station (AS) should be committed to memory, because these terms are used frequently in the PCS 7 software and in this document.*

- *The option is provided to replace the CPU414-3DP, depending on the available hardware, with another CPU, a PC based SIMATIC PCS 7 AS RTX or the SIMATIC PCS 7 Box PC.*
Figure 8: Various plant configurations with SIMATIC PCS 7 Box, SIMATIC PCS 7 AS RTX and SIMATIC S7-400 CPU 414-3DP as controller (from left)

**Note:**

- In the following chapters, the S7-PLCSIM simulation software is used for testing the programs. This allows the user to basically configure any controller.
6 Planning

The devices to be used in the instructions can already be obtained from the task description. The following order numbers must be used for this:

<table>
<thead>
<tr>
<th>Module</th>
<th>Order number</th>
<th>Firmware</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS 407 10A</td>
<td>6ES7 407-0KA02-0AA0</td>
<td></td>
</tr>
<tr>
<td>CPU 414-3 DP</td>
<td>6ES7 414-3XM05-0AB0</td>
<td>V5.3</td>
</tr>
<tr>
<td>CP443-1</td>
<td>6GK7 443-1EX20-0XE0</td>
<td>V2.1</td>
</tr>
</tbody>
</table>

Table 1: S7 station (SIMATIC S7-400)

<table>
<thead>
<tr>
<th>Module</th>
<th>Order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>IM 153-2</td>
<td>6ES7 153-2BA02-0XB0</td>
</tr>
<tr>
<td>DI32xDC24V</td>
<td>6ES7 321-1BL00-0AA0</td>
</tr>
<tr>
<td>DI16xNAMUR</td>
<td>6ES7 321-7TH00-0AB0</td>
</tr>
<tr>
<td>DI16xDC24V, Alarm</td>
<td>6ES7 321-7BH01-0AB0</td>
</tr>
<tr>
<td>DO32xDC24V/0.5A</td>
<td>6ES7 322-1BL00-0AA0</td>
</tr>
<tr>
<td>DO16xDC24V/0.5A</td>
<td>6ES7 322-8BH10-0AB0</td>
</tr>
<tr>
<td>AI8x14Bit</td>
<td>6ES7 332-7HF01-0AB0</td>
</tr>
<tr>
<td>AO8x12Bit</td>
<td>6ES7 332-5HF00-0AB0</td>
</tr>
</tbody>
</table>

Table 2: Distributed I/O (ET 200M)

7 Learning objective

In this chapter, students learn the following:

– Creation of a PCS 7 project
– Creation of the hardware configuration for an S7 station
– Creation of the hardware configuration for a PC station with WinCC
– Networking of an S7 station and a PC station
8 Structured step-by-step instructions

8.1 Creating a project

1. The central tool in SIMATIC PCS 7 is SIMATIC Manager, which is opened here with a double-click. (→ SIMATIC Manager)

2. Use of the wizard for creating a PCS 7 project is recommended because it creates the S7 station and the PC station in one step (→ File → 'New Project' Wizard)
3. The project is to be created here as a multiproject. This means a master library will be created in addition to the S7 station and PC station. The library ensures that the same version of blocks and chart templates (process tag types) is always used within a project. (→ Next)
4. Next, we select the configuration of the AS with the CPU used, the power supply and the communications processors for PROFIBUS and Ethernet. Because PCS 7 stations are usually ordered as an entire station (bundle), it is possible to select the bundles here based on their order numbers. We are using the bundle with description ‘AS414-3 V5.3; AC10A; UR2; CP443-1EX20’. (→ CPU: AS414-3 → 6ES7*** → Number of communication modules CP443-5 → 0 → Next)

![PCS 7 Wizards 'New Project']

**Notes:**

- The number of additional communication modules for PROFIBUS is added here in an additional selection.
- Because the bundles listed here often do not correspond 100% to the existing S7 station, individual components may have to be added or exchanged later in the hardware configuration.
5. We now select the number of hierarchy levels for the plant hierarchy (refer to chapter ‘Plant Hierarchy’) and an OS object. (→ Number of levels: 3 → AS objects: none → OS objects: PCS7 OS → Single station system → Next)

![PCS 7 Wizard: 'New Project'](<image>)

6. The storage location and directory name (also project name) are specified and the project is finished in the following window (→ Storage location: any → Directory name: SCE_PCS7 → Finish)

![PCS 7 Wizard: 'New Project'](<image>)
7. Confirm the dialog that appears. (→ OK)

8. After the project is finished, it is opened and displayed in the Component view as well as in the Plant view. You can switch between the views in the menu under View. (→ View)
Note:

- Additional information on the Component view and Plant view is provided in chapter ‘Plant Hierarchy’. In this chapter, only the Component view familiar from STEP 7 is used.

9. To avoid future warnings due to a missing System ID, the SID ‘3007-00A0-1ABD’ previously created for SCE projects is entered. (→ SCE_PCS7_MP → Object Properties → System ID: 3007-00A0-1ABD → OK)
Note:

– The System ID is used to register a project at Siemens in order to simplify support. It is optional and therefore does not have to be entered. If it is not entered, PCS 7 generates the message described in step 7 above each time a project is opened. This message can be ignored.
8.2 Configuring the S7 station

1. Next, we select the SIMATIC S7-400 station in the Component view and open the hardware configuration with a double click. (→ Component view → SIMATIC 400(1) → Hardware)

2. To make the settings for Ethernet networking, we select the PN-IO interface with a double click in the CP 443-1. (→ PN-IO)
3. Here, a device name can be assigned and the properties for the Ethernet interface can be selected. (→ Properties)
4. In the parameters, we enter an IP address and a subnet mask and create a new subnet. (→ Parameters → IP address: 192.168.0.1 → Subnet mask: 255.255.255.0 → New)

5. Then we apply the subnet and the settings. (→ OK → OK → OK)
8.3 Connection of the I/O signals

1. Next, we configure an ET 200M as a field device on PROFIBUS. In doing so, we have to set the appropriate profile first. Then we select the appropriate interface module from the catalog in folder PROFIBUS DP/ET200M and move it onto the master system of the CPU using drag-and-drop. (PROFIBUS DP → ET 200M → IM 153-2 HF → PROFIBUS(1): DP master system(1))

Notes:

- To select the correct interface module, you must pay attention to the order numbers. They are printed on the interface module and in the footer of the hardware catalog as soon as you have selected a component.

- If you do not have your own hardware available, it is best to adhere to what is shown here.
2. In the following selection, you assign the PROFIBUS address for the interface module. 
   (→ Address: 3 → OK)

![Properties - PROFIBUS interface IM 153-2](image)

**Note:**
- The address set here must also be set on the interface module in binary code using a switch block. The user can obtain additional information on this in the manual of the interface module.
3. Now, you enter the I/O modules from the folders below the interface module used. This is done by dragging these modules to the respective slot within the ET 200M. The I/O addresses of the individual modules should be set in their properties as shown here.

When your configuration is complete, apply it with the button for saving and compiling.

(→ PROFIBUS DP → ET 200M → IM 153-2 HF → DI-300 → DO-300 → AI-300 → AO-300 →
Set addresses →)
### Notes:

- To select the correct module, you must pay attention to the order numbers. They are printed on the modules and in the footer of the hardware catalog as soon as you have selected a component. If you do not have your own hardware available, it is best to adhere to what is shown here.

- You can facilitate the search for the correct modules by utilizing the search dialog at the very top of the catalog. There, you simply enter the order number you are looking for and you can search the entire catalog up or down.

- Slot 3 remains free. It is reserved for the expansion module with a multi-tier configuration.

- In order to use the specified symbol table, it is important to set the specified I/O addresses.
8.4 Configuration of the PC station

1. Next, we select the SIMATIC PC station in the Component view of SIMATIC Manager and open the configuration with a double click. (→ Component view → SIMATIC PC Station(1) → Configuration)
2. Within the PC station, the Ethernet interface must be entered first. To do this, we drag the CP-Industrial Ethernet in version V8.2 from IE General to the first free slot in the PC station. In the window that is displayed next, we connect this interface with the Ethernet network already set up in the S7 station and enter the IP address and the subnet mask. (→ SIMATIC PC Station → CP-Industrial Ethernet → IE General → SW V8.2 → IP address: 192.168.0.2 → Subnet mask: 255.255.255.0 → Subnet: Ethernet(1) → OK)
3. An Ethernet interface and the WinCC application are now entered in the PC station. We apply this configuration by clicking on the **button for saving and compiling.**

8.5 Networking

1. To check and compile the networking in our project, we now open the Ethernet network in the Component view of SIMATIC Manager with a double-click. (Component view → SCE_PCS7_Prj → Ethernet (1))
2. The NetPro tool provides a good overview of the components and networks in our project. We see that both stations are connected to each other via Ethernet and that ET 200M is interfaced with the SIMATIC S7-400 via PROFIBUS. We apply these network settings by clicking on the button for saving and compiling. (→)

3. In the next window, we select 'Compile and check everything'. (→ Compile and check everything → OK)
4. The result of the compilation is displayed in a window. (→ X)

![Image of compilation result]

8.6 Checklist – step-by-step instruction

The following checklist helps students to independently check whether all steps of the step-by-step instruction have been carefully completed and enables them to successfully complete the module on their own.

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Checked</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Multiproject present</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>S7-400 configured</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>CP: Ethernet address set</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>ET 200M configured</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>PROFIBUS and I/O addresses set</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>PC station configured</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Networking performed</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Project successfully archived</td>
<td></td>
</tr>
</tbody>
</table>

Table 3: Checklist for step-by-step instructions
9 Exercises

In the exercises, we apply what we learned in the theory section and in the step-by-step instructions. The existing multiproject from the step-by-step instructions is to be used and expanded for this.

Note:

- *The exercises can be carried out without having to first work through the step-by-step instructions completely and correctly. To get to the stage of the project needed for the exercises, the project archive provided can be unzipped and opened using the 'Retrieve' function. (→ File → Retrieve…).*

The name of the project archive for the step-by-step instructions is: p01-02-project-r1905-en.zip. The download of the project is stored as zip file "Projects" on the SCE Internet for the respective module.

The following exercises are recommended especially for users of the PCS 7 Trainer Package because an AS RTX Box will be integrated in these exercises. The AS RTX Box is also an automation station and can handle the same tasks as the previously configured S7-400.

For that reason, this exercise is not mandatory for execution of the overall project.

9.1 Tasks

1. Insert the new AS by right-clicking the project and selecting "Add new object" and then "Preconfigured Station ...". In the dialog box that opens, select the "PCS7 BOX" as CPU and then the "AS RTX" with order number 6ES7654-0UE13-0XX0. Continue along with the dialog without making any other settings.

2. Because the AS RTX Box is a PC based automation station, you should now have a second SIMATIC PC station in the project. You should now assign your stations meaningful names; for example, SIMATIC 400(1) is named AS1, SIMATIC PC Station (1) is named OS and SIMATIC PC Station (2) is named AS2.

3. Next, network the AS RTX Box (=AS2) with the Ethernet (1) and with a new PROFIBUS master system PROFIBUS (2). You must open the configuration of the AS2 for this. So far, your AS has only one interface to PROFIBUS, "CP5611-CP5621". For this reason, add an IE General. Assign the Ethernet interface parameters exactly as described in the step-by-step instructions. For parameter assignment of the PROFIBUS interface, you need to open the properties and add a new PROFIBUS network.
4. So that the new AS can actually undertake the tasks of the AS1, you need the identical ET 200M. You have two options for adding the ET 200M including the I/O cards. The first option corresponds to the configuration as provided in the step-by-step instructions. The second option is to copy the previously created ET 200M and insert it with a right-click on the PROFIBUS (2) line.

9.2 Checklist – exercise

The following checklist helps students to independently check whether all steps of the exercise have been carefully completed and enables them to successfully complete the module on their own.

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Checked</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PCS 7 BOX / AS RTX inserted in the multiproject</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>AS1, AS2 and OS present in the project</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Networking performed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>New ET 200M configured</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Project successfully archived</td>
<td></td>
</tr>
</tbody>
</table>

Table 4: Checklist for exercises
10 Additional information

More information for further practice and consolidation is available as orientation, for example: Getting Started, videos, tutorials, apps, manuals, programming guidelines and trial software/firmware, under the following link:

siemens.com/sce/pcs7

Preview "Additional information"

Getting Started, Videos, Tutorials, Apps, Manuals, Trial-SW/Firmware

➤ SIMATIC PCS 7 Overview
➤ SIMATIC PCS 7 Videos
➤ Getting Started
➤ Application Examples
➤ Download Software/Firmware
➤ SIMATIC PCS 7 Website
➤ SIMATIC S7-400 Website
Further Information
Siemens Automation Cooperates with Education
siemens.com/sce
Siemens SIMATIC PCS 7
siemens.com/pcs7
SCE Learn-/Training Documents
siemens.com/sce/documents
SCE Trainer Packages
siemens.com/sce/tp
SCE Contact Partners
siemens.com/sce/contact
Digital Enterprise
siemens.com/digital-enterprise
Industrie 4.0
siemens.com/future-of-manufacturing
Totally Integrated Automation (TIA)
siemens.com/tia
TIA Portal
siemens.com/tia-portal
SIMATIC Controller
siemens.com/controller
SIMATIC Technical Documentation
siemens.com/simatic-docu
Industry Online Support
support.industry.siemens.com
Product catalogue and online ordering system Industry Mall
mall.industry.siemens.com

Siemens
Digital Industries, FA
P.O. Box 4848
90026 Nuremberg
Germany

Subject to change and errors
© Siemens 2020

siemens.com/sce